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1 Introduction

 The Mx4pro Development Tools is a Windows 95/98/NT/2000-based
development platform for Mx4 system tuning, analysis, and program
development.  The Mx4pro Development Tools v5.00 manual will assist you in
setting up your hardware and software needed to use the Mx4pro
Development Tools v5.00. The manual includes illustrated references for using
the powerful features of the development tools such as oscilloscopes, signal
generator, gain tools, data viewers, system frequency analyzer, and DSPL
programming environment.
 

Note: Appendix A provides tutorial information on Tuning A
System.

What’s New in Mx4pro Development Tools

Mx4pro Development Tools takes full advantage of the features offered in the
32-bit Windows operating systems. DSPL development, system tuning, system
analyzing, table downloading, and several other tasks may be performed in one
easy to use environment. Furthermore, all of the tools may be operating
simultaneously. The following is a brief overview of the new and/or improved
tools included with the Mx4pro Development Tools:

•  DSPL compiler with advanced math functions and macros.
•  Internet connectivity, view manuals and application notes.
•  DSPL programs may be edited, compiled, downloaded, and controlled

(started and/or stopped) from within the DSPL Development Tool.
•  Gains for all axes may be changed in real time and then stored in

initialization files that can be linked to your DSPL programs for future use.
•  The Signal Generator and Oscilloscope will work in both Bus and Serial

mode and allow easy tuning and analyzing of your Mx4 applications.
•  The Frequency Analyzer allows you to analyze your system performance

and models your system with up to a 20th order transfer function.
•  G Code programs may be edited, compiled, downloaded, and controlled

(started and/or stopped) from within the G Code Development Tools.
•  DSPL variables may be monitored and changed in real time.
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•  Inputs may be monitored and outputs changed in real time.
•  Interrupts may be monitored, cleared, and disabled in real time.
•  Position, Velocity, Cam, and Cubic Spline data tables may be downloaded

from within the Mx4pro Development Tools environment.
•  All tools (excluding Frequency Analyzer) work in either Bus or Serial

communication mode.

About Mx4pro Development Tools v5.00

The Mx4pro Development Tools v5.00 will assist you in taking full advantage of
all included features in the Mx4pro Development Tools v5.00 during
development, tuning, and testing of your Mx4 based applications.  Each of the
chapters are described below.

Chapter 1: Introduction
Summarizes some of the reference materials available through DSP Control
Group, Inc. which will assist you, along with the Mx4pro Development Tools, in
development, tuning, and testing of all your Mx4 based applications.  The new
features included with the Mx4pro Development Tools are also discussed.

Chapter 2: Installing Mx4pro
This chapter summarizes the system requirements and describes how to set up
your Mx4 hardware and Mx4pro software.

Chapter 3: Licensing
Describes the Mx4pro Development Tools licensing (acquiring a license
number) and how to run the Mx4pro in Demo mode for evaluation.  Also
discussed is how to upgrade from a demo version to a licensed version and/or
add new options.

Chapter 4: Internet Features
Describes how to use the Internet Features in the Mx4pro Development Tools to
download the latest software, view the application notes, and view the frequently
asked question.
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Chapter 5: DSPL Program Development
Describes how to use the DSPL Development Tool to open, edit, compile,
download, and control the execution of DSPL programs.

Chapter 6: Real Time Command
Describes how to use the Real Time Command Window to send real time
commands to the Mx4 or the Mx4 Octavia.

Chapter 7: Frequency Analyzer
Describes how the Frequency Analyzer may be used to graphically analyze the
performance, bandwidth, stability, etc. of your system.  Also explains how your
system may be modeled using the Frequency Analyzer, which displays your
modeled system both graphically (Bode plot) and mathematically (up to 20th

order transfer function).

Chapter 8: Gain Tool
Describes how to use the Gain Tool to modify the Mx4 position loop gains and
notch filter parameters for any axis.  Also, the modification of Vx4++
parameters (current loop gains, PWM frequency, current limit, etc.) are
described.  In addition to explaining these settings, saving Mx4 and Vx4++
parameters and linking them into DSPL programs is described.

Chapter 9: Signal Generator
Shows how to use the Signal Generator Tool to generate trapezoidal and
sinusoidal velocity profiles, which are useful for system tuning and optimization.

Chapter 10: Scopes
Describes how to start Time and XY Scopes using the Scope Tool.  Also shows
how to configure both the Time and XY Scopes to graphically monitor the state
variables for any axis in real time.

Chapter 11: Viewers
Explains how to use the DSPL Variable Viewer, Inputs and Outputs Viewer,
Interrupts Viewer, and State Variable Viewers to monitor and change variables;
monitor inputs and change outputs; monitor, clear, and disable interrupts; and
monitor state variables, in real time.
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Chapter 12: Tables
Explains how to use the Cubic Spline Table Tool, Cam Tables Tool, Position or
Velocity Points Table Tool, and Position and Velocity Compensation Tables
Tool to open, edit, download, or clear cubic spline tables; cam tables; position or
velocity tables; or position and velocity compensation tables.

Chapter13: G Code Program Development

Describes how to use the G Code Development Tool to open, edit, compile,
download, and control the execution of G Code programs.

Chapter 14: Advanced Topics
This chapter discusses all of the advanced topics of the Mx4pro Development
Tools.  Explains how to configure an editor to be used by Mx4pro, configure
update timers, change the Mx4 card address communication link, and modify
resource sharing priorities. Commands for resetting serial communications,
resetting timers for graphical displays, and resetting the Mx4 are also covered.
Lastly, configuring the communications involved between the Mx4 and Mx4pro
using the Windows Registry is explained.

Appendix A: Tuning A System
This appendix provides a thorough reference and procedure for tuning a system
in either velocity or torque loop.  General familiarity with the Mx4pro
Development Tools should be obtained before using this appendix.

 In conjunction with this manual you may find the following items of assistance:

Mx4 User’s Guide
This manual includes comprehensive information on Mx4’s hardware, system
tuning, memory organization, trouble shooting and more.  The Mx4’s User’s
Guide is the focal point for learning the technical details of the Mx4.  All other
manuals assume that users have already read the Mx4 User’s Guide.
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DSPL Programmer’s Guide
This manual will assist you with DSPL, DSPCG’s high level programming
language for the Mx4. DSPL has its own compiler and downloader, which are
included in the Mx4pro Development Tools.

Gcode User’s Guide
This manual will provide you comprehensive information on DSPCG’s gcode
interface.  Some of the information the manual includes is using the development
tools, gcode programming, a complete list of supported gcodes, and example
programs.

Vx4++ User’s Guide
This manual includes information on the add-on drive control option, Vx4++.
Vx4++ is DSPCG’s multi-DSP based drive controller that provides complete
drive signal processing for all industrial DC and AC machines. The capabilities
of Vx4++ include those normally offered by servo control amplifiers.



Introduction

1-6

This page intentionally left blank.



Mx4pro Development Tools v5.00                                                                                                                 2-1

2 Installing Mx4pro

This chapter will guide you through the process of installing the Mx4pro
Development Tools on a PC running Windows 95/98 or Windows NT/2000.
Before beginning the installation procedure, take a moment to read this chapter,
there are several prerequisites which must be fulfilled before the installation of
the Mx4pro Development Tools can proceed properly.

System Requirements

Before the Mx4pro Development Tools may be installed and used, you must
have the following:

•  An IBM PC/AT or 100% compatible ISA/EISA based PC
•  A RS-232/485 serial communications port, if the Development

Tools will be used in Serial Mode
•  Microsoft Windows 95/98 or Windows NT/2000
•  A minimum of 6 Megabyte of open disk space on the harddrive
•  SVGA monitor suggested

Preparing the Hardware

This section explains how to prepare the PC/AT Mx4 and Mx4 Octavia
hardware for the Mx4pro Development Tools.  The Mx4pro Development Tools
can be run in one of three modes, Bus, Serial, or Demo.  In Bus mode, the Card
Address and IRQ must be configured for ISA/PC bus communication. In Serial
Mode, a RS-232/485 Serial Communications port must be used. When running
in Demo mode a Mx4 or Mx4 Octavia Card is not required.

Bus Mode Settings
For the Mx4pro Development Tools to operate in Bus mode there must be a card
located on a 2K boundary for the Mx4 and on a 8K boundary for the Mx4
Octavia within the ISA base 1Meg address space and the IRQ must be set.  Refer
to chapter 2, “Installing Your Mx4 Hardware” in the Mx4 User’s Guide or the
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Mx4 Octavia User’s Guide. The 10-position DIP switch SW1 is used to select
the start of this boundary (Table 2-1).

Note: It is important to make sure that the chosen address space of
the Mx4 or the Mx4 Octavia card does not interfere with other
hardware on the PC Bus.

ADDRESS MATCHED

POSITION SW OFF SW ON

SW1-1 A19=1 A19=0

SW1-2 A18=1 A18=0

SW1-3 A17=1 A17=0

SW1-4 A16=1 A16=0

SW1-5 A15=1 A15=0

SW1-6 A14=1 A14=0

SW1-7 A13=1 A13=0

SW1-8 (Mx4) A12=1

(Octavia)  nc

(Mx4) A12=0

(Octavia)  nc

SW1-9 (Mx4) A11=1

(Octavia)  nc

(Mx4) A11=0

(Octavia)  nc

SW1-10 Nc Nc

Table 2-1: PC/AT Mx4 2K Boundary Select

For example, setting the card address space to 0xD0000 (i.e. the 64K segment)
would require the SW1 DIP switch to be set as follows,

OFF

1 2 3 4 5 6 7 8 9 10

In addition to the card address, the desired IRQ level issued to the host computer
must be set. To set the IRQ level, select the proper jumper JU3 (Table 2-2).
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Note: When selecting the IRQ level, make sure that this value will
not interfere with a previously selected value for other hardware in
your PC.

JUMPER
POSITION

INTERRUPT
SELECTED

JU3-1 IRQ15

JU3-2 IRQ14

JU3-3 IRQ12

JU3-4 IRQ11

JU3-5 IRQ10

JU3-6 IRQ9

JU3-7 IRQ7

JU3-8 IRQ6

JU3-9 IRQ5

JU3-10 IRQ4

JU3-11 IRQ3

   Table 2-2:  PC/AT Mx4 Host Bus Interrupt Select

Serial Mode Settings
For the Mx4pro Development Tools to operate in Serial mode there must be a
Mx4 card connected to the RS-232/485 serial communications port (1 through
4).  Furthermore, if RS-485 serial communication is being used, the Slave Node
Address of the Serial Adapter Card must be set. Refer to the Acc4 User’s Guide
or Acc8 User’s Guide for more information.

Demo Mode Settings
If the Mx4pro Development Tools are being used in Demo mode, then a Mx4
card is NOT required. Furthermore, if a Mx4 card is located on the PC BUS or
connected to a serial port, the Mx4pro Development Tools will not affect the
card. That is, all operations in the Mx4pro Development Tools will NOT be
transmitted to the Mx4 card while in Demo mode.

Installing the Mx4pro Development Tools
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This section explains how to install the Mx4pro Development Tools software.
The Mx4 card address, IRQ, Serial Port number, and/or Slave Node Address
(described above) will need to be specified during the setup procedure, these
values are used to configure the Mx4pro Development Tools.

Note: If a previous version of Mx4pro Development Tools exists
on your PC it is recommended that you first uninstall the previous
version before installing the new version. See the section
“Removing Previous Versions of Mx4pro Development Tools” at
the end of this chapter.

To start the installation procedure of the Mx4pro Development Tools while
using Windows 95/98, select Run under the Start button and enter SETUP (with
the path to the Mx4pro media, CD or diskette), then press the Enter button.  You
may also double click on the icon that represents the drive and/or folder where
the Mx4pro installation media is located (under My Computer) and double
click on the Setup icon.

To start the setup procedure within Windows NT/2000, select Run under the
File menu of the “Program Manager Window” and enter SETUP (with the path
to the Mx4pro media, CD or diskette), then press the Enter button.  You may
also double click on SETUP.EXE from within the File Manager focusing on the
drive and/or folder where the Mx4pro installation media is located.

When the setup process begins, several files will first be copied to your PC to
assist you through the remainder of the setup process.  After these files have
been copied successfully, you must specify the drive and path where you would
like the Mx4pro Development Tools to be installed (or use the default path).
After the drive and path have been specified, click on the indicated button to
proceed with the setup. The setup process will prompt you for each disk as it is
needed.  After all of the files have been installed, you will be prompted with the
following configuration windows:
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Fig. 2-1: Card Selection window

Select the type of controller which you have installed, either Mx4 Octavia (5-8
axes) or Mx4 (4 axes).

Note:     The remaining sections of this manual are presented from the
perspective of a 4-axis Mx4 controller installed.  If you have
installed a 5-8 axis Mx4 Octavia, the descriptions herein are
still useful (simply, axes 1-4 descriptions for Mx4 may be
expanded to axes 1-8 for Mx4 Octavia).
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The next window configuration window is the Expansion Option Window.

Fig: 2-2: Expansion Option Window for Octavia

The Expansion Option window lets you select some of the options available for
the Mx4 family.  If you have one of the listed options installed select the correct
radio button, if you have an option that is not listed or you have on options
installed select No Expansion Card.

Fig. 2-3: Communication Options window
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From within the Communications Options window the mode of operation must
be selected (BUS or Serial), that is the communication path between the Mx4pro
Development Tools and the underlying Mx4 card must be specified. If the
Mx4pro Development Tools will be used in Demo mode, just click on the OK
button.

For Bus mode select the Bus Communications option and enter the values of
the Mx4 Card Address and IRQ you selected during the hardware setup.  For
Serial Mode, select the Serial Communications option and enter the
Communications Port the serial Mx4 card will be connected to and the Slave
Node Address selected during hardware setup.  If you are using RS-232
communications, leave the Slave Node Address as 1.  Now click on the OK
button and the Mx4pro Development Tools will be configured for your hardware
specification. The configuration parameters for Mx4pro are stored in the
Registry, for more information on these configuration parameters refer to
Chapter 14, Advanced Topics. At this point, the Mx4pro Development Tools
have been installed.

After the setup procedure has completed, you will find three directories placed
inside the root directory you had installed the Mx4pro Development Tools into:
HLL, DAT, and GCODE.  The HLL and DAT directories contain several
tutorial DSPL and data files, respectively.  These files will assist you in learning
and mastering the DSPL high level language.  The GCODE directory contains a
sample GCODE tutorial file and a README file to assist you in programming
with G Code. Also, for your convenience, a shortcut to Mx4pro Development
Tools is placed on your “Desk top” if you are using Windows 95/98.

Removing Previous Versions of Mx4pro
Development Tools

There are several ways of removing the previous version of the Mx4pro
Development Tools. From within Windows 95/98, this can be done by selecting
Add/Remove Programs in the Control Panel, then selecting the “Mx4pro
vx.xx” text in the installed components list and clicking on the Add/Remove
button. To uninstall the previous version of Mx4pro Development Tools from
within Windows NT/2000, open the Mx4pro vx.xx window under the Program
manager, then double click on the Remove Mx4pro vx.xx icon.
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Note: If uninstalling the files in either fashion described above, all
of the files that were copied to your PC during the previous
installation will be removed.  Therefore, if you made changes to
the installed tutorial DSPL files, data files, or G Code files, they
must be copied to another directory if you would like to preserve
the changes.  Any files you may have created in these directories
will not be affected during either the uninstall process or the new
installation

Note: Previous DOS versions of Mx4pro (v3.xx) do not need to be
removed.

Starting the Mx4pro Development Tools

After you have finished the hardware (not needed if running in Demo mode) and
software setup procedures, the Mx4pro Development Tools may be started.  If
you have installed Mx4pro on a computer using Windows 95/98, then the
Mx4pro Development Tools may be started by either clicking on the Start
button and then selecting Mx4pro v5.00 under the Mx4pro v5.00 group within
the Programs main group, or by double clicking on the Mx4pro v5.00 shortcut
on the desktop.  If installed in Windows NT, double click on the Mx4pro v5.00
icon inside the Mx4pro v5.00 group within the Program Manager.

The first time that the Mx4pro Development Tools are started you will be
prompted with a Licensing window, refer to chapter 3 on Licensing.  After you
have finished entering your licensing information, the following toolbar will
appear:
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3 Licensing

To start using the Mx4pro Development Tools, you must either acquire a license
number or run in Demo mode.  After Mx4pro Development Tools have been
properly setup and started for the first time, you will be prompted to enter your
Name, the name of your Company and a License Number. The following
window will prompt you for this information:

Fig. 3-1: License Information window

All of the Licensing information should be entered, begin by entering your
Name and your Company, then enter your License Number.  To acquire your
License Number you must contact DSP Control Group, Inc. by fax or email with
your name, company and the generated ID Number. The License Number
enables Mx4pro Development Tools to execute and allows you to use the
options you have specified to be included in your License.

Note:  The License Number is unique for all computers,
that is a License Number from Mx4pro on one computer
will not work with Mx4pro on a different computer.
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Alternatively, Mx4pro Development Tools may be run in Demo mode by
entering DEMO (in upper case) for the License Number.  When Mx4pro
Development Tools is run in Demo mode, all options with the Mx4pro
Development Tools may be viewed; however, no communication with Mx4 is
established.

Note: An Mx4 card is NOT needed while in Demo mode.
If a Mx4 card does reside on the computer running
Mx4pro in Demo mode, the Mx4 will NOT be used.

Changing the License Number

After initially entering a License number or running Mx4pro Development Tools
in Demo mode, the License Number may be updated to either allow the Mx4pro
Development Tools to run in normal mode (as opposed to Demo) or to update
your currently licensed options.  From the Start Menu select Run…,  type
regedit into the command window and press Enter.  This will start the registry
editor.

Note: Use caution when editing the registry, deleting or
editing values could result in program failures or lockups.

Select HKEY_CURRENT_USER. Next, select Software\MX4PRO\License.
This will open the Mx4 License values. Double click on the value labeled
LicenseNumber.  Type the new license number in the Value data window.
Click on the OK button. Exit the registry editor.



Mx4pro Development Tools v5.00                                                                                                                  4-1

4 Internet Features
Double click on center to open internet features

Double clicking on the center on the Mx4pro window will bring up the online
options for the Mx4pro Tools. This opens the homepage for the DSPCG website,
http://www.dspcg.com see Fig. 4-1.

Internet Options

The majority of the technical assistance is under the Support and Download
buttons. Under the support page the available choices are to view the frequently
asked questions (FAQ), and view the application notes. Under the download
page one can download the latest software versions, the application notes, and
the user manuals. The frequently asked questions are sorted by product, and the
application notes have a short description for each topic. The download page
allows one to get the latest software. Some of the software available for
download is multiple versions of the DSPL compiler, multiple versions of the
Windows DLL, and the latest version of the Mx4pro Development Tools.

http://www.dspcg.com/
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Fig. 4-1: DSPCG Homepage
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5 DSPL Program
       Development

Click button to open DSPL Program Development Tool

The DSPL programming language is a high-level language resembling C which
allows complete motion control programs to be written for the Mx4. The DSPL
Program Development Tool allows you to create, modify, compile, download,
and execute DSPL programs.  The DSPL Development Tool may be opened by
clicking on the DSPL button on the Mx4pro Development. Now the following
window will appear:
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Fig. 5-1: DSPL Development Tool

The DSPL Development tool displays the name of the open DSPL File, the Path
for the open file, and the Status of a compile and/or download performed on the
file. The following sections describe how to utilize the different features of the
DSPL Development Tool.

Opening DSPL Files
Before a DSPL program can be edited, compiled, or downloaded, it must be
opened by the user.  To open a DSPL program:

1. Open the DSPL Selection window.  This can be achieved by selecting
Open... under the File menu or in the popup menu (right click in the DSPL
Development window). Double-clicking inside one of the three black areas
(File, Path, or Status text boxes) inside the DSPL Development window
(Figure 5-1) will also open the DSPL Selection window.

2. Select the DSPL File. To open a file, browse your harddrive to the path
where your project will exist or does exist, then click on the filename or
enter the file name in the File Name text box. Note, there is a File Type
filter.  After your file has been selected, click on the OK button to accept
your selection or the Cancel button to disregard (Figure 5-2).
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Fig. 5-2: DSPL Selection window

Editing Files
After a file has been opened, it may be edited.  This can be achieved by selecting
Edit under the File menu or in the popup menu. The opened file will then be
placed into a text editor, to select the editor used for editing the DSPL programs,
refer to “Selecting an Editor” in Chapter 14 Advanced Topics.
A file which has not been opened may also be edited via the DSPL Selection
window. Follow steps 1 and 2 above, then select the Edit button instead of the
OK button (Figure 5-2). The file will then be opened with the editor, but not into
the DSPL Development tool. This feature is useful when an “include” file needs
to be edited or created.

Compiling Files
An opened DSPL file can be compiled using the DSPL Development tool, but
make sure you save the file first, if it has been edited.  To compile the DSPL file,
select Compile under the Build menu or in the popup menu. For example, by
selecting Compile from within the popup menu, the DSPL compiler will compile
the opened DSPL program (Figure 5-3).
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Fig. 5-3   Compiling DSPL Program

After the compile has started, it may be canceled by selecting Cancel Compile
under the Build menu.

If the DSPL compiler detects any warnings or errors during the compilation of
the opened file, the Status box in the DSPL Development Tool will display a
warning/error message and an edit session displaying the warnings and/or errors
will appear.

Downloading Files
If the opened file has been compiled successfully, it can be downloaded to the
Mx4 card by selecting Download under the Build menu or in the popup menu.

The opened DSPL file may also be compiled and downloaded if Compile and
Download is selected under the Build menu or in the popup menu.
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Note: If Compile and Download was used and any warning(s)
and/or error(s) occurred, then the file will NOT be downloaded.
If only warnings were issued the file may still be downloaded, but
Download must be used instead of Compile and Download.

Executing DSPL Programs
There are several commands that may be issued to control the execution of a
downloaded DSPL program. The following commands may be issued to the Mx4
via the DSPL Development Tool by selecting the appropriate command under
the Run menu,

•  Start DSPL - Starts the DSPL program execution
•  Stop DSPL - Stops the DSPL program execution
•  Signal DSPL - Signals the DSPL program, breaks out of a 

WAIT_UNTIL_RTC command in a DSPL program.
•  AutoStart DSPL - Select AutoStart On or AutoStart Off to turn 

the autostart option on or off, respectively.

A DSPL program may also be started or stopped by selecting Start DSPL or
Stop DSPL, respectively, from within the popup menu. Furthermore, the
function keys F1 through F3 may be used to issue the Start DSPL (F1), Stop
DSPL (F2), and Signal DSPL (F3) commands when the DSPL Development
Window is active.

Refer to  the Mx4 User’s Guide and the DSPL Programmer’s Guide for more
information on these commands.

Closing the DSPL Development Tool
To close the Mx4pro Development Tool, select Close under either the File menu
or in the popup menu. The opened DSPL file and path along with the window
dimensions and position are saved, when the window is started again the same
DSPL file will be opened and the window will appear in the same location as
when it was closed.
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DSPL Programming Notes
•  For further information on programming with DSPL, refer to the DSPL

Programmer’s Guide.
•  For further information on the Mx4 and its RTC’s refer to the Mx4 User’s

Guide.
•  In order to work properly, all DSPL programs must be compiled and

downloaded using the compiler and downloader that are a part of the
Mx4pro Development Tools package.
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6 Real Time Command
Click on button to open RTC command window

The Real Time Command Window allows one to send real time commands
(RTC) to the Mx4. RTCs can be used to set parameters and execute simple
moves. The Real Time Command Window may be opened by clicking on the
RTC button on the Mx4pro Development Tools main window. Now the
following window will appear:

Fig. 6–1: Real Time Command Window
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RTC Commands

To send a RTC, type the command into the window then press Send. The RTCs
are in DSPL format. For example here is an axmove command for axis 3:

axmove(0x4, 0.05, 10000, 10)

For complete description of the arguments and usage of RTC commands consult
the DSPL Programmer’s Guide.

Note: All of the available Mx4 RTC commands are NOT
supported by the Real Time Command Window.

The text will remain in the command window, and will not be cleared.  To send
the same RTC again all that is required is to press the Send button. It is also
possible to edit the RTC in the command window, and send the same RTC with
different arguments. To send a different RTC press the Clear button.

The commands available in the Real Time Command Window are:

autostart_dspl disabl2_int
axmove en_bufbrk
axmove_s en_encflt
axmove_t en_err
cam_off en_errhlt
cam_off_acc en_index
crtl_ka en_motcp
ctrl en_posbrk
cubic_int encode_mag
cubic_rate estop_acc
cubic_scale flux_current
curr_limit gear_off_acc
curr_offset gear_off_acc
curr_pid gear_probe
ddac gear_off
disabl_int inp_state
int5ms posbrk_out
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kilimit pwm_freq
low_pass rel_axmove
maxacc rel_axmove_s
motor_par rel_axmove_t
motor_tech signal_dspl
notch start_dspl
offset stepper_on
outgain stop_dspl
outp_off sync
outp_on table_sel
override trq_limit
pos_preset vector4_block
pos_shift velmode
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7 Frequency Analyzer

Click button to open the Frequency Analyzer Tool

An important tool included with the Mx4pro Development Tools is the
Frequency Analyzer or Bode plot.  The Frequency Analyzer allows the system
performance, bandwidth, stability, and modeling transfer function, to be viewed
graphically. This chapter will explain how to use all of the features supported by
the Frequency Analyzer Tool.

Frequency Analyzer Tool

The Frequency Analyzer Tool allows the frequency analysis for each axis to be
configured and executed.  It also allows the modeling transfer function to be
configured and viewed. To open the Frequency Analyzer Tool click on the
Frequency Analyzer Tool button on the main Mx4pro Development Tools. The
following window will appear:
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Fig. 7-1: Frequency Analyzer Tool

Besides the main window, two graphs for magnitude and phase will appear.
These windows will look as follows (these windows display the analysis results):

  

Fig. 7-2: Frequency Analyzer Magnitude and Phase plots

Before a system may be analyzed, the Frequency Analyzer must be configured
for the desired axis to analyze.  To choose the axis, select the desired axis from
the drop box located under the Start/Stop button. Now the Amplitude and
Frequency must be specified, the Amplitude is the magnitude of the excitation
signal in counts (50 count minimum) and the Frequency is the maximum
frequency (between 20 and 200 Hz) of the excitation signal (Figure 7-1).

To start the analysis click on the Start button, the button will now display Stop
and the analysis will begin.  When the analysis routine completes, the Magnitude
and Phase plots will be updated and the button will display Start again.  To stop
the analysis prematurely,  click on the Stop button.
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Note:  It is the responsibility of the user to set the control gains for
the axis being analyzed before the frequency analyzer will run for
that axis.

Note: The frequency analyzer uses a DSPL program, therefore any
existing DSPL program loaded on the Mx4 card will be
overwritten.

Note: Right clicking in the Magnitude or Phase windows will
display the Main Window for the Frequency Analyzer and the
Parameters windows.

System Modeling

The Frequency Analyzer Tool allows the system to be modeled with a transfer
function in the z-domain. To model the system set the Numerator and
Denominator to the desired powers of z and then start the analysis as explained
above (Figure 7-1). The powers may range from 0 to 20, where powers of 0 will
turn the modeling feature off.

After the analysis has completed the modeled transfer function will be displayed
in the Magnitude and Phase plots (red trace).  Furthermore, the coefficients for
the transfer function may be viewed by clicking on the View Params button.  A
window similar to the following will appear:
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Fig. 7-3: System Model Parameters

If this window is already open, the coefficients will be updated automatically.
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8 Gain Tool

Click button to open Gain Tool

The Gain Tool included with the Mx4pro Development Tools allows you to
manipulate all of the position loop gains and the notch filter frequency for all
axes of the Mx4.  Also, with the Vx4++ commutation controller option card, the
drive control parameters (for all axes) may be modified in real time. There are
three windows associated with the Gain Tool, one is dedicated to the Mx4
controller (Mx4 Gains window) and the other two are dedicated to the optional
Vx4++ controller (Vx4++ Gains and Vx4++ Parameter Settings windows).

Note:   Appendix A: Tuning A System contains a thorough step-by-
step tutorial on the process of tuning a system in either velocity or
torque loop.
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Mx4 Gains Window

The Mx4 Gains window may be opened by clicking on the Gain Tool button on
the Mx4pro Development Tools. The Mx4 Gains window appears as follows:

Fig. 8-1: Mx4 Gains window in Gain Tool

The Mx4 Gains window displays the position loop gains, notch filter frequency,
and current axis of focus. From within this window these values can be modified
in real-time for all axes.  Furthermore, the values for the position loop gains may
be saved to an initialization file for future use.

Axis Selection
The current axis which the Mx4 Gains window is focusing on is displayed in the
upper right corner of the window.  That is, all changes and updates to the
position loop gains and notch filter frequency values will be for the current axis
which has focus.  To change the values of the other axes, the axis of focus must
be changed to the desired axis.

There are three methods available for changing the current axis, the first method
is to select the desired axis from the list of axes Axis 1, Axis 2, Axis 3, Axis 4,
Axis 5, Axis 6, Axis 7, and Axis 8 under the Axis menu. The Mx4 has four axis
and the Octavia has up to eight axis.  The second method is to select the desired
axis from the list of axes, Axis 1, Axis 2, Axis 3, Axis 4, Axis 5, Axis 6, Axis 7,
and Axis 8 inside the popup menu (right click inside the Mx4 Gains window).
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The third method is to select the function key which represents each axis, that is,
F1 will switch to axis 1, F2 to axis 2, F3 to axis 3, F4 to axis 4, F5 to axis 5, F6
to axis 6, F7 to axis 7 and F8 to axis 8.  Notice that inside the Axis menu and
popup menu, the axis which currently has focus will have a check mark beside it.

Note: Changing the axis of focus inside the Mx4 Gain window
will cause the focus of the Vx4++ Gains window to be on the same
selected axis.

Updating Current Mx4 Gains and Notch
Frequency Values
When the Mx4pro Development Tools are initially started the position loop
gains, notch filter frequency, and notch filter Q factor value are read from the
Mx4 and updated to the Mx4 Gain window.  In addition, every time the axis of
focus is changed as described in the previous section, these values are also
updated from the Mx4 to the Mx4 Gain window.  When it is necessary to refresh
the gains from the Mx4 to the Mx4 Gain window (for example if the gains are
changed outside the Mx4pro Development Tools), they can easily be refreshed
by reselecting the current axis of focus (see section above on axis selection) or
select Refresh under the Axis menu or popup menu. Pressing the F5 function
key for the Mx4 and F9 for the Mx4 Octavia will also refresh the windows.

Note: If the position loop gains or notch filter frequency values on
the Mx4 have been changed outside the Mx4pro Development
Tools (for example if a DSPL program changes the gains) they will
not be automatically updated inside the Mx4 Gain window.

Changing the Position Loop Gains
The position loop gains of the Mx4 may be changed in real time using the scroll
bar next to each of the individual gains, to scroll up or down in increments of 10.
This method of gain selection is useful for tuning your system in real time.  The
gains may also be changed by entering a new gain value into the corresponding
text box.  The enter key does not need to be pressed, since the Gain Tool will
notice the change in the keyed or scrolled value, this current value (if it is valid)
will be issued to the Mx4 card as a new gain.
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Note: If the entered value for the gain is too large, then the
previous gain value will be placed into the text box and used as the
new gain to be issued to the Mx4.

Changing the Notch Filter Frequency
and Q Factor
The Notch filter frequency and Q factor of the Mx4 may be changed in real time
using two methods.  To change the notch filter frequency, the knob in the Notch
box may be used to rotate left or right to change the frequency.  In addition to
the knob, the frequency (in Hz) may be entered into the text box. As with
changing the gains, the enter key does not need to be pressed, since the Gain
Tool will notice the change in the keyed value. This current value will be issued
to the Mx4 card as a new notch frequency.

To change the Q factor, select the new Q factor from the list under the Notch
menu or inside the popup menu (right click on the top of the Notch box).  Notice
that the current Q factor has a check mark beside it in both of these lists.

Note: If the entered value for the notch frequency is too large, the
maximum notch frequency value will be placed into the text box
and used as the notch frequency to be issued to the Mx4.

Saving Gains and Linking into DSPL
Programs
The current position loop gains from the Mx4 Gain window can be saved to a
DSPL initialization file and then linked into any DSPL file for future use.  To
save the gains, select Save Gains under the File menu.  The gains will be saved
to the file called MX4_INIT.HLL, which will be located in the directory
containing the Mx4pro Development Tools program.  After the file has been
saved, it can be linked to any DSPL file by using the DSPL directive #include.
For more information on include files and the DSPL language refer to the DSPL
Programmer’s Guide.
The following simple example shows how to include the saved initialization file
and how to call it from within a motion program,

#include “C:\Mx4proV5\init_mx4.hll” ; Assumes Mx4pro v5 exists
  ; in C:\Mx4proV5 directory

•
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•
•

MOTION_PROGRAM:
•
•
•

   call(INIT_MX4) ;Calls the saved gains initialization file
•
•
•

END

Note: Only the Ki, Kp, Kf, and Kd gains will be saved for all axes.
Before using the INIT_MX4.HLL file in an application, review the
HLL file first.

Closing Mx4 Gains Window
To close the Mx4 Gains Window,  select Close under the File menu or in the
popup menu. Upon closing the window dimensions and position are saved, so
that the next time the Mx4 Gain window is opened it appears in the same
location as before it was closed.

Vx4++ Gains Window

After starting the GainTool to acquire the Mx4 Gains Window, the Vx4++ Gains
window may be opened.  To open the window either select Vx4++ Gains under

the File menu or click on the  image.

The Vx4++ Gains window displays the loop gains, PWM frequency, field
current, current offset, and axis of focus. From within this window these values
can be modified in real-time.  Furthermore, all of the Vx4++ values may be
saved to an initialization file for future use.
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Fig. 8-2: Vx4++ Gains window in Gain Tool

Axis Selection
The axis which the Vx4++ Gains window is focusing on is displayed in the
upper right corner of the window.  That is, all changes and updates to the loop
gains, PWM frequency, field current, current offset, and motor type will be for
the axis which has focus.  To change the values of the other axes, the axis of
focus must be changed to the desired axis.

There are three methods available for changing the current axis, the first method
is to select the desired axis from the list of axes, Axis 1, Axis 2, Axis 3, and Axis
4 under the Axis menu. The second method is to select the desired axis from the
list of axes, Axis 1, Axis 2, Axis 3, and Axis 4 inside the popup menu (right
click inside the Vx4++ Gains window).  The third method is to select the
function key which represents each axis, that is F1 will switch to axis 1, F2 to
axis 2, F3 to axis 3, and F4 to axis 4.  Notice that inside the Axis menu and
popup menu, the axis which currently has focus will have a check mark beside it.

Note: Changing the axis of focus inside the Vx4++ Gain window
will cause the focus of the Mx4 Gains window to be on the same
selected axis.
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Updating Current Vx4++ Gains, PWM
Frequency, Field Current, Current
Offset and Motor Type
When the Mx4pro Development Tools are initially started, the loop gains, PWM
frequency, field current, current offset, and motor type values are read from the
Mx4 and updated to the Vx4++ Gain window. Also, every time the axis of focus
is changed (described in the previous section) these values are also updated from
the Vx4++ to the Vx4++ Gain window.  When it is necessary to update any of
the values from the Vx4++ to the Vx4++ Gain window (for example if the loop
gains are changed outside the Mx4pro Development Tools), they can be
refreshed by reselecting the current axis of focus (see section above on axis
selection) or select Refresh under the Axis menu or popup menu. Selecting the
F5 function key will also refresh the loop gains, PWM frequency, field current,
current offset, and motor type values.

Note: If the loop gains, PWM frequency, field current, current
offset, and motor type values on the Vx4++ have been changed
outside the Mx4pro Development Tools (for example if a DSPL
program changes the loop gains) they will not be automatically
updated inside the Vx4++ Gain window.

Changing the Loop Gains
The loop gains of the Vx4++ may be changed in real time using the scroll bar
next to each of the individual gains to scroll up or down in increments of 10.
This method of gain modification is useful for tuning your system in real time.
The gains may also be changed by entering a new gain value into the text box.
The Enter key does not need to be pressed, since the Gain Tool will notice the
change in the keyed or scrolled value, this current value (if it is valid) will be
issued to the Vx4++ as a new gain.

Note: If the entered value for the gain is too large, then the
previous gain value will be replaced into the text box and used as
the new gain to be issued to the Vx4++.

Changing the PWM Frequency
The PWM (Pulse Width Modulation) frequency of the Vx4++ may be changed
in real time by rotating the knob in the PWM box left or right to change
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frequency.  In addition to the knob, the frequency may be entered into the text
box.  As with changing the gains, the Enter key does not need to be pressed,
since the Gain Tool will notice the change in the keyed value. This current value
will be issued to the Vx4++ card as a new frequency.

Note: If the entered value for the PWM frequency is too large, the
maximum frequency value will be placed into the text box and
used as the new PWM to be issued to the Vx4++.

Changing the Field Current
The field current of the Vx4++ may also be changed in real time using the knob
in the Field box to rotate left or right, thus changing the field current.  In addition
to the knob, the field current may be entered into the text box.  As with changing
the gains, the Enter key does not need to be pressed, since the Gain Tool will
notice the change in the keyed value. This current value will be issued to the
Vx4++ card as a new field current.  The field current values have different
ranges for different motor types, if the motor type of BRUSHTYPE DC is used,
the field current has no effect and therefore is disabled for this motor type.

Note: If the entered value for the field current is too large, the
maximum value will be placed into the text box and used as the
new field current to be issued to the Vx4++.

Changing the Current Offset
The current offset of the Vx4++ may be changed in real time using the knob in
the Offset box to rotate left or right, modifying the current offset.  In addition to
the knob, the current offset may be entered into the text box. Again, the enter key
does not need to be pressed, since the Gain Tool will notice the change in the
keyed value. This current value will be issued to the Vx4++ card as a new
current offset.

Note: If the entered value for the current offset is too large, the
maximum value will be placed into the text box and used as the
new current offset to be issued to the Vx4++.
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Changing the Motor Type
There are two simple methods available for changing the current motor type used
with the Vx4++.  First the motor type may be selected under the Motor menu,
selections are BrushType DC, Brushless DC, and AC Induction.  It may also

be changed by right clicking on the motor image and selecting the
desired motor type from the list.  Notice that inside the Motor menu and popup
menu, the motor type currently selected will have a check mark beside it.

Saving Vx4++ Parameter Values and
Linking into DSPL Programs
The values from the Vx4++ Gain window and Vx4++ Settings window
(discussed below) can be saved to a DSPL initialization file and then linked into
any DSPL program for future use.  To save the values, select Save under the File
menu.  The values will be saved to the file called INIT_VX4.HLL, which will be
located in the directory containing the Mx4pro Development Tools program.
After the file has been saved, it can be linked to any DSPL file by  using the
DSPL directive #include.  For more information on include files and the DSPL
language refer to the DSPL Programmer’s Guide.  The following simple
example shows how to include the saved initialization file and how to call it from
within a motion program:

#include “C:\Mx4proV5\init_vx4.hll” ; Assumes Mx4pro V5 exists
      ; in C:\Mx4proV5 directory

•
•
•

MOTION PROGRAM:
•
•
•

   call(INIT_VX4)    ;Calls the saved gains initialization file
•
•
•

END

Note: All Vx4++ parameters and the Kp, Ki, Kf, and Kd gains
from the Mx4 will be saved. Before using the INIT_VX4.HLL file
in an application, review the file first.
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Closing Vx4++ Gains Window
To close the Vx4++ Gains Window, select Close under the File menu or in the
popup menu. The window position and dimensions will be saved when the
window is closed, then next time the Vx4++ Gains window is opened it will
appear in the same location.

Vx4++ Fixed Parameter Settings Window

From within the Vx4++ Gains window, the Vx4++ Fixed Parameter Settings
window may be opened.  To open the window either select Setup under the File
menu or from within the popup menu.

The Vx4++ Settings window displays the encoder lines per revolution, number
of motor poles, commutation option, current limit, and motor parameter for the
current axis of focus. From within this window all of these values may be
modified.  The Settings window appears as follows:

Fig. 8-3: Vx4++ Settings window in Gain Tool

Motor Setup
From within the Motor Setup group, the encoder lines per revolution, number of
motor poles, and commutation option may be programmed. To set the desired
values  enter the values in the text boxes (don’t need to press enter) and click on
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the desired commutation option. The range for the encoder lines per revolution is
1 to 8191. The range for the poles is 0 to 256.

Note: If the entered value for either the encoder lines per
revolution or number of motor poles are outside the range of
allowable values, the Setting window will not close after selecting
OK and a message will appear noting the source of the problem.

Current Limit
From within the Current Limit group, the current limit may be selected.  To set
the desired value enter the percentage of current limit (0 to 100%) in the text
box, the Enter key does not need to be pressed.
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Motor Parameter
From within the Motor Parameter group, the slip gain (AC Induction motor) or
commutation angle (DC Brushless motor) may be selected.  To set the desired
value  enter the motor parameter (-32768 to 32767) in the text box. The Enter
key doesn’t need to be pressed.

Note: If the entered value for motor parameter is outside the range
of allowable values, the Setting window will not close after
selecting OK and a message will appear noting the source of the
problem.

Transmitting the Settings to the Vx4++
After selecting the encoder lines per revolution, number of motor poles,
commutation option, current limit, and/or  motor parameter, these values may be
issued to the Vx4++ by clicking on the OK button. To cancel the Settings, that is
not issue the currently selected values to the Vx4++, select the Cancel button.



Mx4pro Development Tools  v5.00                                                                                                                9-1

9 Signal Generator

Click button to open Signal Generator Tool

The Mx4pro Development Tools contain a signal generator which is useful for
optimizing your system. The signal generator is able to generate either
trapezoidal or sinusoidal velocity profiles.  This chapter will explain how to start
and use the Signal Generator Tool.

Signal Generator Tool

The Signal Generator Tool allows trapezoidal and sinusoidal velocity profiles to
be configured, started, and stopped for all axes. To open the Signal Generator
Tool  click on the Signal Generator Tool button on the main Mx4pro
Development Tools.  The following window will appear:
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Fig. 9-1: Signal Generator Tool

To start the signal generation click on the Start button, the start button will now
display Stop.  After the motion has started, clicking on the Stop button will stop
the motion.  The axis on which the motion should occur can be selected from the
drop box next to the Start/Stop  button, scroll down the list and select the
desired axis.  To select the desired velocity motion profile, trapezoidal or
sinusoidal, simply select Trapezoid  or Sine from the dropdown box.  Before
starting the motion you must also configure the profile, described below.

Note:  It is the responsibility of the user to set the control gains for
an axis before the signal generator is run for that axis.  If the
control gains are not set by the user, the signal generator may not
generate axis motion as expected.

Note: When the signal generator starts, the MAXACC value for
the specified axis is changed to 1.0 counts per (200 µsec)2.
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Sinusoidal Profile
There are two parameter fields for the Sinusoidal velocity profile.  The first is
the Amplitude, this controls the amplitude of the velocity for the sinusoidal
signal and has units of counts per 200 µsec.  The other parameter field is Period,
this field controls the period of the sinusoidal signal in units of milliseconds.

Trapezoidal Profile
The trapezoidal profile, which is generated using an Mx4 AXMOVE command,
contains four parameter fields for customizing the Trapezoidal velocity profile.
The first field is Acceleration, which is the value (in counts per (200 µsec)2)
used to accelerate from the current velocity to a new target velocity.  Another
field is Velocity, this value is (in counts per 200 µsec) the target velocity for the
motion. The Velocity corresponds to the amplitude of the trapezoidal velocity
profile.  The third parameter is Position, which is the value of the target position
for a motion.  That is, the motion will oscillate between 0 and the target position.
The final parameter, Delay, specifies the amount of delay in milliseconds
between the positive and negative direction of the motion.

Note: The signal generator makes use of the DSPL programming
language, therefore any existing DSPL program loaded on the Mx4
card will be overwritten.

Note: The signal generator will turn off automatically whenever
the sine or trapezoid parameters are modified, or when the type of
signal is changed.
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10 Scopes

Click button to open Scope Tool

The Mx4pro Development Tools supports three separate real-time scopes while
in Bus mode and a single real-time scope while in Serial mode.  The scopes
allow the state variables of the Mx4 to be viewed graphically as they change with
time.  The Mx4 state variables are position, velocity and error of each axis.  Two
different types of scopes are available, a Time Scope and a XY Scope.  This
chapter will explain how to start and use all of the supported scopes.

Scope Tool

The Scope Tool allows the Time and XY scopes to be started.  To open the
Scope Tool click on the Scope Tool button on the main Mx4pro Development
Tools.  The following window will appear:
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Fig. 10-1: Main Scope window in Scope Tool

To start a Time scope simply select the Time Scope button and to start an XY
Scope select the XY Scope button.  Again, in Bus mode a maximum of three
scopes may be running simultaneously, of these three only one can be a XY
Scope.  In Serial mode one scope, either Time or XY may be running.

Note: Only one instance of the Main Scope Window may be
executing at any time.  If another Main Scope Window is
commanded to open, an error message (“Could not run Scope”)
will appear.

Note: Only one XY Scope can be executing at a time, if a second
XY Scope is commanded to open, an error message (“An XY
Scope already exists.”) will be displayed.

Note: While Mx4pro is in Serial mode and a Time or XY Scope is
open, then other computationally intensive tools will operate
slowly. Also, you may get error messages that certain commands
were not transmitted to the Mx4. These can be partially avoided by
turning one of the channels off while opening other tools.

Clicking on either of the buttons in the main scope window will cause two
additional windows to appear, a Scope Settings Window and a Scope Display
Window (discussed below).  The two windows are paired with one another, so
the Scope Settings Window titled “Scope Settings 1” controls the Scope Display
window titled “Scope 1”.  At any time, the Scope Settings Window for a
particular Scope Display Window can be displayed by clicking the right mouse
button while the pointer is inside the particular Scope display window.
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Note: The Scope Tool shares resources with other Mx4
Development Tools (such as the Frequency Analyzer), therefore
you may not always be able to start three scopes.  An error
message (“Could not open a scope. Insufficient resources. Refer to
documentation.”) will be displayed if additional scopes are unable
to open.

Time Scope

The Time Scope displays up to two separate Mx4 state variables (vertical axis)
against time (horizontal axis).  The units per division in both the vertical and the
horizontal directions can be adjusted and an offset value may be specified in
real-time causing the display to be “shifted” up or down as desired.  Triggering
options are also available when using a Time Scope.  After opening a Time
scope, the following two windows will appear:

   

Fig. 10-2: Time Scope windows
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Time Scope Channel and Time Scale
Settings
From within the Time Scope Settings window, the Time Scope may be easily
customized for the desired state variables to be monitored.  The Channel 1 and
Channel 2 groups allow the units per division, state variable being monitored,
and origin offset to be selected.  The channel may also be turned off and on
(Figure 10-2). The following list explains each of the functions for the Channel
group,

•  UNITS/DIV: This knob controls the number of units displayed in each
vertical division of the corresponding Scope Display window.  The
UNITS/DIV knob for Channel l is green and corresponds to the green
trace on the Scope display window, the Channel 2 UNITS/DIV knob is
red and sets the scale for the red trace.  The units of each division
depend on the selected state variable.

•  State Variable Selection: One of the twelve Mx4 state variables can be
displayed by either or both channels  by selecting the appropriate state
variable from the drop box. The current state variable is displayed in
the top of the drop box. The state variables are abbreviated with the
following format, state_variable:axis_number, for example VEL2 is
the velocity state variable for axis 2.  If the state variable for a channel
is displaying either a POS or ERR value, then the UNITS/DIV knob
specifies the number of encoder counts displayed in each division.  If a
VEL state variable is being displayed the UNITS/DIV specifies the
number of counts per 200 µsec are being displayed in each vertical
division.

•  Origin Offset: An offset value can be entered by the user in order to
shift the corresponding trace upwards or downwards.  The offset
entered indicates the value of the horizontal white line (origin) for that
channel in the Scope Display Window. The entered offset units
correspond to the units of the selected state variable for that channel.

•  ON/OFF: Turns the scope trace for that channel in the Scope Display
window on or off.  A check inside the box to the left of the ON/OFF
label indicates that the corresponding trace is being displayed.

•  TIME/DIV: This knob controls the units of time (in milli-seconds) for
each horizontal division of the corresponding scope.  The value selected
is used as the horizontal units per division for both channels.
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Triggering for Time Scopes
From within the Time Scope Settings window, the triggering for the Time Scope
may be configured. First the triggering for the scope must be enabled, this is
achieved by selecting Ch.1 inside the appropriate list box (this will set the scope
to trigger off state variable selected for Channel 1).  To turn the triggering off,
simply select Off in the same list box (Figure 10-2).

The Triggering can occur on either the positive or negative slope of the trace.
The slope may be selected from the second list box in the Trigger Group by
selecting Positive for a positive slope trigger and Negative for a negative slope
trigger.  The trigger offset can be set by entering the offset into the edit box in
the Trigger Group, the units of offset are the same as the selected state variable
for channel 1.  After the triggering has been enabled the trigger slope and offset
will take effect.

XY Scope

The XY Scope plots one value of the Mx4 state variable against another as the
variables change with time.  The units per division and offset for the scope
channels may also be selected. After opening a Time scope, the following two
windows will appear:

   

Fig. 10-3: XY Scope windows
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XY Scope Axis and Sample Settings
From within the XY Scope Settings window, the XY Scope may be customized
for the desired state variables being monitored.  The X-Axis and Y-Axis groups
allow the units per division, state variable being monitored, and origin offset to
be selected. The following list explains each of the functions for the XY Scope
Settings window,

•  UNITS/DIV: This knob controls the number of units displayed in each
division of the corresponding Scope Display window.  The UNITS/DIV
knob for the X-Axis controls the units per division for the horizontal
axis and UNITS/DIV knob for the Y-Axis controls the units per
division for the vertical axis on the Scope display window.  The units of
each division depend on the selected state variable.

•  State Variable Selection: One of the twelve Mx4 state variables can be
displayed by either or both axes by selecting the appropriate state
variable from the drop box.  The current state variable is displayed in
the top of the drop box.  The state variables are abbreviated with the
following format, state_variable:axis_number, for example  VEL2 is
the velocity state variable for axis 2.
 If the state variable for a channel is displaying either a POS or ERR
value, then the UNITS/DIV knob specifies the number of encoder
counts displayed in each division.  If a VEL state variable is being
displayed the UNITS/DIV specifies the number of counts per 200 µsec
are being displayed in each vertical division.

•  Origin Offset: An offset value can be entered by the user in order to
shift the corresponding axis origin. The offset entered indicates the
value of the corresponding white line (origin) for the axis in the Scope
Display Window.  The entered offset units correspond to the units of
the selected state variable for that channel.

•  SAMPLES: This knob controls the number of samples which will be
displayed on the scope.  The number of samples corresponds to the
number of 5ms samples in Bus mode and 10ms samples in Serial mode.
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Closing Scopes

All opened scopes and the Main Scope window may be closed by closing the
Main Scope window, or the individual scopes may first be closed, then the Main
Scope window can be closed.  If the Main Scope window is closed while scope
windows are open, the next time the Main Scope window is opened the scopes
which were open prior to the closing of the Main Scope window will also be
opened and their previous settings will be restored.  If each of the individual
scope windows are closed and then the Main Scope window is closed, then all of
the setting for these closed scope windows will be lost.
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11 Viewers

Click button to open Viewer.

After clicking on the Viewer button, the Viewer menu opens it has all the
viewers for Mx4pro, a reset button, and the table downloaders in the options
menu.

Viewer

The Mx4pro Development Tools supports four real-time viewers, a DSPL
Variable Viewer, Inputs and Outputs Viewer, Interrupts Viewer, and State
Variable Viewer. These viewers monitor the DSPL variables, Mx4 inputs, Mx4
interrupts, and the state variables in real-time.  They also allow the DSPL
variables to be changed, outputs to be set/cleared, and interrupts to be cleared
and/or disabled. This chapter will explain how to use all of the viewers
supported by the Mx4pro Development Tools.
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Fig. 11-1:  Viewer

State Variable Viewer

The State Variable Viewer allows the position, velocity, and following error
state variables for all axes to be monitored in real-time. To open the State
Variable Viewer click on the State Viewer Tool button on the Mx4 Viewer. The
State Variable Viewer looks as follows:

Fig. 11-2: State Variable Viewer for Mx4
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Viewing State Variables
The position, velocity, and following error state variables for all axes may be
viewed simultaneously, the state variable names are listed down the left column
and the corresponding axis for each state variable is listed across the top row.
The units for the state variables are in counts for the position and following error
and in counts/(200µsec) for velocity.

Pausing Updates
Updating of the state variables may be paused at any time. This can be done
either by selecting Pause Updating under the File menu or in the popup menu.
When the update timer is paused, a check mark will appear next to the Pause
Updating menu item. To resume the updating, reselect Pause Updating.
Pausing the updates to the window is a simple way to get better response time in
other opened windows during serial communication.

Closing the Viewer
To close the State Variable Viewer either select Close under either the File
menu or the popup menu.  When the window is closed the window dimensions
and window position are saved, so next time the State Variable Viewer is started
it will appear in the same location as when it was closed.  Also, the Pause
Updating flag is removed when the window is closed, so next time it is opened
the updating will occur
.

DSPL Variable Viewer

To open the DSPL Variable Viewer click on the DSPL Variables button on the
Viewer window.  The DSPL Variable Viewer appears as follows:

Fig. 11-3: DSPL Variable Viewer
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The DSPL Variable Viewer allows all DSPL variables to be monitored and
changed in real-time.

Viewing Variables
Four DSPL variables may be viewed simultaneously, the variable number in the
Variable column corresponds to the value displayed in the Value column.  To
view a different variable, change the variable number in the Variable column to
the desired variable number to monitor. The DSPL variables 1 through 64 may
be monitored (Figure 11-3).

Note:  If a MONITOR_VAR RTC is issued outside the
Mx4pro Development Tools environment, then the
variable numbers in the Variable column will NOT match
the value in the Value column. To get them to match you
must re-enter the variable numbers in the Variable
column.

Changing Variables
To change the value of the variable itself, select the variable’s corresponding
Value column location, the value will be highlighted once it is selected.  The
variable value may be selected by either tabbing to the value or by clicking on
the value itself.  While the value is highlighted it is not updated to the DSPL
Variable Viewer, at this point the new value may be entered.  To make the
change take effect, the value box must be unhighlighted. This can be done by
pressing the tab key or by clicking on a different location inside the DSPL
Variable Viewer window (Figure 11-3).

Pausing Updates
Updating of the variables may be paused at any time, this can be done either by
selecting Pause Updating under either the File menu or the popup menu.  When
the update timer is paused a check mark will appear next to the Pause Updating
menu item.  To resume the updating, reselect Pause Updating.  Pausing the
updates to the window is a simple way to get better response time in other open
tools during serial communication.

Closing the Viewer
To close the DSPL Variable Viewer either select Close under the File menu or
in the popup menu. When the window is closed the window dimensions, window
position, and selected variables are saved. The next time the DSPL Variable
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Viewer is started it will appear in the same location with the same settings for the
variables as when it was closed.  Also, the Pause Updating flag is removed
when the window is closed, so next time it is opened the updating will occur.

Interrupts Viewer

The Interrupts Viewer allows all the interrupts to be monitored in real-time.  To
open the click on the Interrupts button on the Mx4 Viewer. The Interrupts
Viewer appears as follows:

Fig. 11-4: Interrupts Viewer for Octavia

Viewing Interrupts
The Buffer Breakpoint, Emergency Stop, Reset Finished, DSPL Host, DSPL
Program Error, External Int, Position Breakpoint, Motion Complete, Offest
Cancel Finished, Encoder Fault, Following Error, Following Error & Halt, and
Index Pulse interrupts are all monitored in real-time.  When an interrupt has
become active the box to the immediate right of the indicated interrupt value will
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be set (red). If the interrupt is not active, the box will be cleared (dark green).
For the Position Breakpoint, Motion Complete, Offest Cancel Finished, Encoder
Fault, Following Error, Following Error & Halt, and Index Pulse interrupts there
are columns, one for each axis, (Figure 11-3).

Clearing and Disabling Interrupts
All interrupts may be cleared or disabled from within the Interrupts Viewer.  To
clear all interrupts click on the Clear All Interrupts button or select Clear All
Interrupts under the File menu or in the popup menu.

To disable all of the interrupts, click on the Disable All Interrupts button or
select Disable All Interrupts under either the File menu or in the popup menu.

Closing the Viewer
To close the Interrupts Viewer either select Close under the File menu or in the
popup menu.  When the window is closed the window dimensions and window
position are saved, so next time the Interrupts Viewer is started it will appear in
the same location as when it was closed.

Inputs and Outputs Viewer

The Inputs and Outputs Viewer allows all inputs and outputs to be monitored
and changed, respectively, in real-time. To open the click on the I/O button on
the Mx4 Viewer.  The Inputs and Outputs Viewer appears as follows:
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Fig. 11-5: Inputs and Outputs Viewer for Mx4 Octavia

Viewing Inputs
All standard inputs, 32 for the Mx4 Octavia and 22 for the Mx4, are monitored
simultaneously.  When an input is active (on) the “light” beside the input number
will light up (displays red).  When the input is inactive or off the “light” will turn
off (displays dark green) (Figure 11-5).
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Setting Output States
All standard inputs, 32 for the Mx4 Octavia and 13 for the Mx4, may be set to
either an active or inactive state and they are monitored simultaneously.  To set
the state of an output to active click on the square box to the right of the desired
output number, now the box will light up as red indicating the output has been
activated.  To set an output state to inactive, click on the box to the right of the
desired output number, the box will then become dark green indicating that the
output state is inactive (Figure 11-5).

Closing the Viewer
To close the Inputs and Outputs Viewer either select Close under the File menu
or in the popup menu. When the window is closed the window dimensions and
window position are saved, so next time the Inputs and Outputs Viewer is
opened it will appear in the same location as when it was closed.
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12 Tables

Mx4pro Development Tools allows you to manipulate four major table formats,
Cubic Spline Tables; Cam Tables; Position or Velocity End Point Tables; and
Position or Velocity Compensation Tables. This chapter explains how to edit
and download these four tables.

Cubic Spline Table

The Cubic Spline Table Tool allows you to create, modify, and download Cubic
Spline data tables.  The Cubic Spline Table Tool may be opened by selecting
Cubic Spline... under the Tables menu in the Mx4 Viewer. Now the following
window will appear:

Fig. 12-1: Cubic Spline Table Tool

The Cubic Spline Table Tool displays the name and path of the opened table and
the number of points that were downloaded.  Furthermore, the offset starting
table index download location can be set. The following sections describe how
to utilize the different features of the Cubic Spline Table Tool.



Tables

12-2

Opening a Cubic Spline Table
Before a Cubic Spline data table can be edited or downloaded, it must by opened
by the user.  Opening a Cubic Spline table is the same as opening a DSPL
program, follow this method:

1. Open the Cubic Spline Selection window.  This can be achieved by
selecting Open... under either the File menu or the popup menu (right click
in the Cubic Spline Tool window), or by double-clicking inside one of the
two black areas (File or Path text boxes) inside the Cubic Spline Tool
window (Figure 12-2).

2. Select the Cubic Spline Table File. To open a file, browse your hard drive
to the path where your table will exist or does exist, then click on the
filename or enter the file name in the File Name text box.  Notice, there is a
File Type filter.  After your file has been selected, click on the OK button
to accept your selection or the Cancel button to disregard your selection
(Figure 4-2).

Editing a Cubic Spline Data File
After a Cubic Spline table has been opened, it can be edited by either selecting
Edit Table under the File menu or in the popup menu (right clicking in the
Cubic Spline Table window).

The Cubic Spline Tables can have one of the following formats (for a 4-axis
table):

Position Point 1 ⇐  Axis 1
Position Point 1 ⇐  Axis 2
Position Point 1 ⇐  Axis 3
Position Point 1 ⇐  Axis 4
Position Point 2 ⇐  Axis 1
Position Point 2 ⇐  Axis 2
Position Point 2 ⇐  Axis 3
Position Point 2 ⇐  Axis 4

•
•
•

or:

Axis 1 Position P1    Axis 2 Position P1   Axis 3 Position P1    Axis 4 Position P1
Axis 1 Position P2    Axis 2 Position P2   Axis 3 Position P2    Axis 4 Position P2

        … …  …        …
The Position Points must be entered in units of counts and scaled between -
2147483648 and 2147483647 counts.
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Note: The data points are read from left to right and top to
bottom.

Note: There should be no blank lines in the data file, a blank line
will cause the next expected value to be inferred as a value of zero.

Downloading the Cubic Spline Table
Before an opened Cubic Spline Table may be downloaded, the offset starting
index for the download must be set (Figure 12-1).

The offset is the position in the Mx4’s Cubic Table where the opened Cubic
Spline data file will begin to be downloaded to.  If the opened Cubic Spline data
file is too large for the area between the chosen offset and the end of the Mx4
Cubic Spline table, an error message will appear. To select an offset, simply
enter an offset value between 0 and 4095 into the Offset text box.

Now the opened Cubic Spline table may be downloaded to the Mx4 card.   This
can be achieved by clicking on the Download button or by selecting Download
Cubic Table under the Commands menu or in the popup menu (right click in
the Cubic Spline Table Tool window).  Once the table download has completed,
the number of points actually downloaded to the Mx4 Cubic Spline table is
displayed in the Points Downloaded box.

Clearing Cubic Spline Table
All entries in the Mx4 Cubic Spline table may be set to 0 (i.e. cleared) by
selecting Clear Cubic under the Commands menu.

Closing Cubic Spline Table Tool
To close the Cubic Spline Table Tool, select Close under the File menu or the
popup menu. The opened table name and path, window position, and window
dimensions will be saved. Next time the Cubic Spline Table Tool is opened, the
saved table will be opened and the window will appear as it did before it was
closed.
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Cam Tables

The Cam Table Tool allows you to create, modify, and download a table of Cam
master/slave position points.  The Cam Table Tool may be opened by selecting
Cam Tables... under the Tables menu in the Mx4 Viewer.  Now the following
window will appear:

Fig. 12-2: Cam Table Tool

The Cam Table Tool displays the name and path of the opened table and the
number of points that were downloaded. Furthermore, the offset starting table
index download location can be set.

Opening a Cam Table
Before a Cam data table can be edited or downloaded, it must be opened by the
user.  Opening a Cam table is the same as opening a Cubic Spline table, follow
this method:

1. Open the Cam Data File Selection window.  This can be achieved be
selecting Open... under either the File or the popup menu (right click in the
Cam Table Tool window), or by double-clicking inside one of the two black
areas (File or Path text boxes) inside the Cam Table Tool window (Figure
12-2).

2. Select the Cam Table File. To open a file, browse your hard drive to the
path where your table will exist or does exist, then click on the filename or
enter the file name in the File Name text box.  Notice, there is a File Type
filter.  After your file has been selected click on the OK button to accept
your selection or the Cancel button to disregard your selection (Figure    4-
2).
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Editing a Cam Data File
After a Cam table has been opened, it can be edited by either selecting Edit
Table under the File menu or in the popup menu.

The Cam Tables must have the following format:

Master axis position    Slave axis position    1
Master axis position    Slave axis position    2
Master axis position    Slave axis position    3
Master axis position    Slave axis position    4

•
•
•

The Cam Master and Slave Position Points must be entered in units of counts
and scaled between -2147483648 and 2147483647 counts (see DSPL
Programmer's Guide or Mx4 User's Guide manuals for descriptions of the CAM
command for further desciption on Cam operation).

Note: The data points are read from left to right and top to bottom.

Note: There should be no blank lines in the data file, a blank line
will cause the next expected value to be inferred as a value of zero.

Downloading the Cam Table
Before an opened Cam Table may be downloaded, the offset starting index for
the download must be set (Figure 12-2).

The offset is the position in the Mx4’s Cam Table where the opened Cam data
file will begin to be downloaded to.  If the opened Cam data file is too large for
the area between the chosen offset and the end of the Mx4 Cam table, an error
message will appear. To select an offset, simply enter an offset value between 0
and 1600 into the Offset text box.

Now the opened Cam table may be downloaded to the Mx4 card.   This can be
achieved by clicking on the Download button or by selecting Download Cam
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Table under the Commands menu or in the popup menu. Once the table
download has completed the number of points actually downloaded to the
selected Mx4 Cam table is displayed in the Points Downloaded box.

Clearing Cam Tables
All entries in the Mx4 Cam tables may be set to 0 (i.e. cleared) by selecting
Clear Cam Table (clears the currently selected table only) or Clear All Tables
(clears both Cam tables) under the Commands menu.

Closing Cam Table Tool
To close the Cam Table Tool, select Close under the File menu or in the popup
menu. The opened table name and path, window position, and dimensions will
be saved. Next time the Cam Table Tool is opened, the saved table name will be
re-opened and the window will appear as it did before it was closed.

Position and Velocity Compensation Tables

The Position and Velocity Compensation Tables Tool allows you to create,
modify, and download tables of Position or Velocity compensation points.  The
Position and Velocity Compensation Tables Tool may be opened by selecting
Position/Velocity Tables... under the Tables menu in the Mx4 Viewer.   Now
the following window will appear:

Fig. 12-4: Position and Velocity Compensation Tables Tool

The Position and Velocity Compensation Tables Tool displays the name and
path of the opened table and the number of points that were downloaded.
Furthermore, the table number and type of table to download to can be set. The
following sections describe how to utilize the different features of the Position
and Velocity Compensation Tables Tool.
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Opening a Position or Velocity
Compensation Table
Before a Position or Velocity Compensation data table can be edited or
downloaded, it must be opened by the user.  Opening a Position or Velocity
Compensation table is the same as opening a Cubic Spline table, follow this
method:

1. Open the Position and Velocity Compensation Data File Selection
window.  This can be achieved be selecting Open... under either the File
menu or in the popup menu (right click in the Position and Velocity
Compensation Tables Tool window), or by double-clicking inside one of the
two black areas (File or Path text boxes) inside the Position and Velocity
Compensation Tables Tool window (Figure 12-4).

2. Select the Position or Velocity Compensation Table File. To open a file,
browse your hard drive to the path where your project will exist or does
exist, then click on the filename or enter the file name in the File Name text
box.  Notice, there is a File Type filter.  After your file has been selected,
click on the OK button to accept your selection or the Cancel button to
disregard your selection (Figure 4-2).

Editing a Position or Velocity
Compensation Data File
After a Position or Velocity Compensation table has been opened, it can be
edited by selecting Edit Table under the File menu or in the popup menu.

The Position or Velocity Compensation tables must have the following format:

Compensation Point 1
Compensation Point 2
Compensation Point 3
Compensation Point 4

•
•
•

The Compensation Points, which must be all Position or all Velocity
Compensation values, are 16-bit two’s complement numbers.  The
Compensation Points may be represented in exponential form (i.e.
0.12345e+002) or in floating point form (i.e. 12.345).
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Note: The data points are read from left to right and top to bottom.

Note: There should be no blank lines in the data file, a blank line
will cause the next expected value to  be inferred as a value of
zero.

Downloading a Position or Velocity
Compensation Table
Before an opened Position or Velocity Compensation Table may be downloaded
the position or velocity table number and type of table (position or velocity) to
download to must be set (Figure 12-4).

The Mx4 contains four tables for each the position and velocity compensation
points.  The tables are referred to as table 1 through table 4. To select which
table to download to, simply click on Table 1, Table 2, Table 3, or Table 4
(representing tables 1, 2, 3, and 4 respectively in the Mx4) in the Table group.

The table type must also be specified so the downloader will download the
opened Position or Velocity Compensation table to the correct table in the Mx4.
To download the opened Position or Velocity table to a Position table, select
Position in the Position or Velocity group, to download to a velocity table
select Velocity.

Now the opened Position or Velocity Compensation table may be downloaded to
the Mx4 card.   This can be achieved by clicking on the Download button or by
selecting Download Table under the Commands menu or in the popup menu.
Once the table download has completed, the number of points actually
downloaded to the selected Mx4 Position or Velocity Compensation table is
displayed in the Points Downloaded box.
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Clearing Position and Velocity
Compensation Tables
All entries in the Mx4 Position and Velocity Compensation tables may be set to
0 (i.e. cleared) by selecting Clear Table (clears the currently selected position or
velocity table only) or Clear All Tables (clears all Position and Velocity
Compensation tables) under the Commands menu.

Closing Position and Velocity
Compensation Tables Tool
To close the Position and Velocity Compensation Table Tool, select Close under
the File menu or in the popup menu. The opened table name and path, and the
window position and dimensions will be saved. Next time the Position and
Velocity Compensation Tables Tool is started the saved table name will be re-
opened and the window will appear as it did before it was closed.
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13 GCode Development
Tools

Click button to open GCode Development Tool.

The Mx4pro GCode Developer is a complete GCode development tool including
a graphical interface along with a powerful GCode to DSPL cross-compiler.
This chapter will give a brief introduction to the GCode Developer for a more
complete explanation consult the GCode User’s Guide.

GCode Interface

The graphical interface is used to control gcode execution. In addition to Mx4
GCode’s many features, it may be used in conjunction with the Mx4pro
development tools to provide the user with an unparalleled motion control
development platform. To open the Gcode Development Interface click on the
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GCode button on the main Mx4pro Development Tools.  The following window
will appear:

Fig. 13-1:   Mx4 GCode Interface

Using the GCode Interface
A simple explanation of the major features is below, consult the GCode User’s
Guide for a complete explanation.

Open GCode

Once a file has been opened, it may be edited, compiled, run, etc.  You may
open a G-Code ASCII file by either selecting  Open G Code in the file menu or
pressing PRG key in the main display window.  Assuming that the GRAPH
window is opened, opening a pre-loaded program will also open its’ graphic file.
Otherwise to see the graph program file must first be loaded.
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Edit GCode

The EDIT button is used to invoke the editor on the G code file which is opened
in the development tool.  The editor may be selected by the options Select Editor
command.  After a file has been edited, it must be refreshed (see Refresh Gcode)
in order for the updated file to be loaded into the development tool.

Load GCode

The LOAD button invokes the cross-compiler which converts the G code file
into a DSPL (the Mx4’s native language) file and downloads this file to the Mx4
controller. This function also generates the XY/YZ/ZX plane view display.  Any
errors and/or warnings which occur during the compile will be displayed.  The
download will not be executed.

Run GCode

The RUN button is used to initiate the execution of a G code file which has been
compiled (in run mode) and downloaded to Mx4.  Again, note that the
development tool must be in run mode before the Run GCode command can be
used.  As the G code file is being executed, the ‘active’ G code line is hi-lighted
in the file text window.
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14 Advanced Topics

This chapter discusses the advanced topics of the Mx4pro Development Tools.
The Mx4pro Development Tools may be configured in several different ways.
For example, Mx4pro can use Serial or Bus communications. Some of Mxpro’s
configuration parameters must be modified inside the Windows Registry, while
others can be modified within the Mx4pro Development Tools. The following is
a list of the configurations which must be altered within the Windows Registry
(discussed later in this chapter):

•  Initial Mx4 Card Address
•  Mx4 IRQ level
•  Communication type (Serial communications port)
•  Slave Node Address
•  Other communication specifics (baudrate, timeouts, etc.)

 
The configurations that may be specified within Mx4pro Development Tools  are
as follows:
 

•  The editor used for editing files
•  The update intervals for the Viewers
•  The current Mx4 card address on the PC Bus
•  The priorities of the critical sections used to share resources

Besides these configurations, several commands may be executed to control the
communications between the Mx4pro Development Tools and the Mx4 itself.
The following is a list of such commands:

•  Reset Serial communications (only if in Serial mode)
•  Reset the update timer for the sampling routines for all Scopes
•  Reset the Mx4 card itself

All of the above mentioned features are discussed below.
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Selecting an Editor

Throughout  the  Mx4pro  Development  Tools  editor  is  used  to  edit  DSPL,
G Code, Tables, etc. Mx4pro Development Tools defaults to the
C:\WINDOWS\NOTEPAD.EXE editor, if this editor is not found, an error
message stating that an editor must be selected will appear.  The editor used to
edit these files can be any text editor that can take a filename to edit as a
command line argument.

To select a different editor simply select the Select Editor... item under the
Options menu in the Mx4 Viewer.  The file selection window (refer to chapter
4: DSPL Development) will appear. Using this selection window, browse to the
drive and path containing the desired editor, then select the editor from the file
list box and click OK.  Now, during the current execution and all future
executions of the Mx4pro Development Tools, the selected editor will be used
for all editing within the Mx4pro Development Tools environment.

Setting Update Timer, Mx4 Address and
Priorities

The update timer, current Mx4 card address, and critical sections for resource
sharing can be configured from within the Settings window.  To open the
Settings window select Custom... under the Options menu in the Mx4 Viewer.
The Settings window appears as follows:

Fig. 14-1: Settings
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There are three major sections to the Settings window, Update Timer, Mx4
Card Address Selection, and Program Priorities.  Each of these three sections
are discussed below.

Update Timer
The update timer specifies the interval of time between the real-time updates of
the Viewer windows (DSPL Variable Viewer, Inputs and Outputs Viewer,
Interrupts Viewer, and the State Variable Viewer). The default time is 100msec.

To set the timer, enter the amount of time (between 50 and 50000msec) into the
Update period box and then click on the Set Timer button.  This will be the
value for the current and future executions of the Mx4pro Development Tool.

Mx4 Card Address Selection
The Mx4 Card Address Selection group allows the Mx4pro Development Tools
communication link to be changed from the initial Mx4 address link to another
Mx4 located on the PC BUS.  This option does not effect Mx4pro if in Serial
mode.  All operations performed by Mx4pro Development Tools will then be on
the newly selected Mx4 card.  That is, all commands issued through the Mx4pro
Development Tools will be issued to the newly specified Mx4 and all updates
will come from the newly specified Mx4 card.

Note:  Setting the Mx4 card address from the Settings
window only effects the currently executing Mx4pro
Development Tools.  To set the Mx4 Card Address
permanently it must be changed in the Windows Registry.

To set the Mx4 card address, enter the new Mx4 address into the Address
selection box, the card address must be a 20-bit hexadecimal number, 0x does
not have to proceed the number, i.e. 0xD0000 and D0000 will be treated the
same.  Besides entering the address, the scroll bar next to the Address edit box
may be used to scroll to the desired address.  After the desired address has been
entered or scrolled to, click on the Change button to issue the change of address.

Note:  If a Mx4 card is not found at the newly specified
address, then the previous Mx4 address will be used.
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Program Priorities
To handle resource sharing, Mx4pro Development Tools uses critical sections
during all Mx4pro to Mx4 communications.  The Program Priorities group
allows the priority level for certain tools in the Mx4pro Development Tools to
have a higher, equivalent, or lower priority then other tools. Setting the priority
levels effect the tools in the following manner, the Viewer Tools (DSPL
Variables, Inputs and Outputs, Interrupts, and State Variables), Gain Tool (Mx4
and Vx4++), Development Tools (DSPL and G Code), and Table Tools (Cubic
Spline, CAM, Points Data, and Position/Velocity) will be allowed to update
more frequently (High Priority), equally frequent (Normal Priority), or less
frequently (Low Priority) than all other Mx4pro Development Tools.

To set the priority levels, click on the desired level, High Priority, Normal
Priority, or Low Priority.

Note:  Setting the Priorities in the Settings window only
effects the currently executing Mx4pro Development
Tools.

Note: Any of the graphical displays (Scope or Frequency
Analyzer) will make all other open tools less responsive,
while operating in Serial mode.
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Resetting Serial Communications

If the communication in Serial Mode is interrupted, Mx4pro Development Tools
will try to reconnect the communications in real-time.  If Mx4pro is unable to
reconnect the communications then the serial communications may be explicitly
reset.

To reset the serial communications, select Reset Serial Communications under
the Options menu or the popup menu (right click on the Mx4pro toolbar).  If
Mx4pro is not in serial mode, a message will appear stating that Mx4pro is not
using the serial communications.

Resetting the Update Timer

During the use of the Scope Tool or Frequency Analyzer Tool in the Mx4pro
Development Tools, while in BUS mode, it is possible for the interrupt supplied
by the Mx4 to cease if, for example, the Mx4 is reset from the outside of the
Mx4pro Development Tools environment.  If the interrupt from the Mx4 is not
enabled, then the Scopes and Frequency Analyzer graphical displays will not
update.  If this occurs, the interrupt can be reinstated by resetting the update
timer.

To reset the update timer simply select Reset Timer under the Options menu or
the popup menu (right click on the Mx4pro toolbar).

Resetting the Mx4

The Mx4 may be reset while using the Mx4pro Development Tools, it is
suggested that the Mx4 is only reset from within the Mx4pro Development
Tools.  If the Mx4 is not reset from within the Mx4pro Development Tools
environment while any of the Mx4pro Development Tools are executing, then
certain tools will either quit updating or display incorrect information.

Resetting the Mx4 from within the Mx4pro Development Tools will reset the
Mx4 and then handle all of the updating needed for the tools in the Mx4pro
Development Tools.  To reset the Mx4, select Reset Mx4 under the Options
menu or in the popup menu (right click in Mx4pro toolbar).
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Note:  All tools in the Mx4pro Development Tools will
be unresponsive until the Mx4 has finished its reset
routines.

Note:  If the Mx4 card address has been changed in the
Card Address selection in the Settings window described
above, then that is the Mx4 which will be reset.

Configuring Communication Parameters
using Registry

All of the permanent Mx4pro configuration parameters are stored in the
Windows Registry. These parameters are stored under the following two keys for
Windows 95/98:

HKEY_CURRENT_USER\Software\MX4
HKEY_CURRENT_USER\Software\MX4PRO

The parameters are stored under the following keys for Windows NT/2000:

HKEY_CURRENT_USER\Software\MX4
HKEY_CURRENT_USER\System\CurrentControlSet-
\Services\DspcgNT\Parameters
HKEY_CURRENT_USER\Software\MX4PRO

The keys, HKEY_CURRENT_USER\Software\MX4 and
HKEY_CURRENT_USER\System\CurrentControlSet\Services\DspcgNT-
\Parameters contains all of the Mx4pro to Mx4 communication configuration
parameters. The other key, HKEY_CURRENT_USER\Software\MX4PRO
contains all of the configuration parameters which are modified from within the
Mx4pro Development Tools environment.
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Note:  It is suggested that only the communication
parameters (HKEY_CURRENT_USER\Software\MX4)
should be modified from within the Windows Registry.
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Communication Configuration
There are several entries within the key
HKEY_CURRENT_USER\Software\MX4 for Windows 95/98 which control
the Mx4pro to Mx4 communications. The following is a list of the entries as they
appear in the registry and a short description of each:

•  Address - Represents the initial 20-bit card address. This must be a
valid address, otherwise the Mx4pro Development Tools will not
execute.

•  BaudRate - Baud Rate while using serial communications (don’t
change).

•  Communication - Type of communications to use, 0 for Bus, non
zero for serial. If using Serial, then this number represents the port
number (1-4).

•  IRQ - Interrupt level generated by Mx4 card at address specified
above.

•  Mutex_TimeOut - Time out for critical sections (don’t change).
•  Read Back_TimeOut - Time out for reading information back

from the Mx4 (don’t change).
•  Serial_TimeOut - Time out for Serial Communications. This value

is used so Mx4pro Development Tools will not “lock up” if the
Serial Communications are lost.

•  SlaveNodeAddress - Slave node address used for RS-485
communications.

There are several entries within the key
HKEY_CURRENT_USER\System\CurrentControlSet\Services\DspcgNT-
\Parameters for WindowsNT/2000 which control the Mx4pro to Mx4
communications. The following is a list of the entries as they appear in the
registry and a short description of each:

•  Address - Represents the initial 20-bit card address. This must be a
valid address, otherwise the Mx4pro Development Tools will not
execute. (Windows NT/2000)

•  Communication - Type of communications to use, 0 for Bus, non
zero for serial. If using Serial, then this number represents the port
number (1-4). (Windows NT/2000)

•  IRQ - Interrupt level generated by Mx4 card at address specified
above. (Windows NT/2000)

•  NumberAxes – The number of  axes on the Mx4 card.(Windows
NT/2000)
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If the Mx4pro Development Tools are configured for Bus Communications then
the BaudRate, Serial_TimeOut, and SlaveNodeAddress entries are ignored. If
configured for Serial Communications, then the Address and IRQ entries are
ignored.
 
 

Note:  All of these values above are stored as double
words, NOT integers.
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APPENDIX A
Tuning A System
This tuning appendix describes how the Mx4 gains are set with servo amplifier
either in velocity or torque loop.  The Mx4pro tools that help us in system tuning
are the Gain Tool, Signal Generator and Oscilloscope.  We will first overview
the setting of the tools and then proceed with tuning.



Tuning A System

A-2

Set A Gain Value
Choosing the Gain Tool allows you to set the control gains. The control block
diagram for one of the 8 motors is selected by pressing the right mouse button on
the Gain Tool window.  You may then set the gains by either typing the values in
the numerical field or using the arrow keys on the gain boxes. For example, set
the proportional gain, Kp, to 1000.

Fig. A-1:    Gain Tool, Kp set to 1000
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Start Signal Generator

Select Signal Generator.  This option allows you to program the parameters of a
short (back and forth) move along a trapezoidal, or sinusoidal trajectory.

Fig. A-2:    Signal Generator

The following is an example of Signal Generator motion parameters:

 Acc = 1               (encoder count per 200µsec2)
 Pos = 1000 (encoder counts)
 Vel = 5 (encoder counts per 200 µsec)

 Delay Time = 200 msec
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Start Oscilloscope

Select the Time Scope and set its Channel 1 and 2 parameters for Velocity and
Position error (in this example both for motor 1)

Fig. A-4:    Oscilloscope Controls

The figure below illustrates real-time display of velocity and position error for
motor one with 50 msec/div. time setting.  To stabilize the signal trace on the
scope, you may trigger the signal on its positive edge.
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Fig. A-5:    Axis 1 velocity/position error display

Proceed With Tuning

There are two methods to tune your system: analytical and practical.

Analytical method is for those who want to do things right the first time.

Proper tuning of any system requires the knowledge of its electromechanical
model. This knowledge, embodied in a transfer function, helps system engineers
design a control law that satisfies their application needs.  For example, a punch
press application requires minimum time control performance whereas machine
tools demands a zero (or near zero) transient error.  If your machine's
mathematical model is known, using a simulation software such as Matlab, you
may proceed with the control design.  You can find information on the Mx4's
control gains (CTRL instruction) and their scaling in Chapter 8 of the DSPL
Programmer’s Guide.   
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Practical method is for those who feel compelled to try things their
own way.

In absence of a mathematical model for your machine, you may use the
following simple steps to fine-tune your system.

Tuning A System with Servo Amplifier in
Velocity Loop

Step 1: Set Feed Forward Gain, Kf
Since most servo amplifiers are already in a closed velocity loop, Kf (velocity
feed-forward gain) must be set such that the velocity command is perfectly
followed.  In this step, you set Kf while all other gains are zero.  The Kf scaling
factor (see CTRL RTC in the Mx4 User’s Guide), motor speed/volt and the
encoder lines/rev., help you compute this gain accurately.

( )K 9.836e 005f
v/krpm

epr= + ⋅

Where: v/krpm : the amplifier command volts per thousand rpm
epr : encoder pulses per mechanical revolution

Example:

Find the Kf value for a system in which a 1v command turns motor
shaft at 1,000 rpm and has a 1024-pulse (per mech. rev.)
incremental encoder.

Solution:

v/k rpm = 1(volts) / 1(k rpm)
= 1.0

epr  =   1024

     ( )K 9.836e 005f
1.0

1024= +

Kf   =  960
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This Kf setting calibrates your motor, amplifier and control combination.

Step 2: Tune proportional gain, Kp
Increasing Kp increases the position loop bandwidth and reduces the transient
error. You may continue to increase Kp until velocity overshoot reaches its
maximum acceptable limit.  To visualize the impact of Kp on a step response,
you must look at the position error and velocity signals simultaneously.  Notice
that the transient and steady state errors are decreased as Kp is increased.

Fig. A-6:   Tuning Kp

Proportional gain, Kp provides a stiffer servo performance but results in too
much overshoot.

Step 3: Tune Kd Gain to Reduce Overshoot
This step is necessary only if the velocity loop damping is less than adequate.
Increasing Kd provides an additional damping and reduces overshoot.
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Fig. A-7:   Tuning Kd to reduce overshoot

Step 4:  Tuning KI, Integral Gain, To Zero
                 Steady-State Position Error
Systems with static friction and a need for zero steady state position error can
benefit from the integral gain. Since integration effect is only desirable when a
system approaches its target position, it is desirable to activate this gain only
when error is small. Also, you may use Kilimit to reduce integral channel's activity
to a few bits and therefore prevents the control signal from going into saturation.
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Tuning A System With Servo Amplifier In
Torque Loop

Step 1: Use Kp to Close the Position Loop
Zero all the gains but Kp. Start with a relatively small Kp value (e.g. 1000).
Increase Kp to reduce position error until you see large velocity overshoots.

Fig. A-8:   Start Tuning by Adjusting Kp to 1000
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Step2: Increase Kd to reduce overshoot

Fig. A-9:    Tuning Kd to reduce overshoot

Notice that while overshoot is eliminated, the transient error is increased
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Step 3:  Increase Kf to reduce Transient
                error

Fig. A-10:    Tuning Kf to reduce transient error
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	In absence of a mathematical model for your machine, you may use the following simple steps to fine-tune your system.






	v/k rpm	=	1(volts) / 1(k rpm)

	This Kf setting calibrates your motor, amplifier and control combination.
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